CHAPTER 10

Stairs, Ramps,
and Railings

A whole chapfter just for stairs, ramps, and railings? You bet! If you think
about it, there could be hundreds of combinations of stair and railing
systems. As a matter of fact, you seldom see two sets of stairs that are exactly
the same. Kind of like snowflakes, aren’t they? OK, they’re nothing like
snowflakes! But you get the point.

This chapter covers the following topics:

Creating stairs by using the Rise/Run function
Creating a winding staircase

Creating a custom railing system

Creating custom stairs

Adding ramps

Creating Stairs by Using the
Rise/Run Function

To begin, this chapter will address the makings of a staircase—from com-
mercial stairs to those with a more residential feel with wood members,
balusters, and spindles. During this procedure, you'll see how the Autodesk®
Revit® Architecture software brings stairs together. After you create a com-
mon staircase, you'll move on to winding stairs, custom railings, and, of
course, ramps.

Before you begin, I should mention that there are some stair-related fea-
tures (or lack of features) in Revit you'll love and some you won’t. As you
create the stairs, keep in mind that Revit can’t always provide enough func-
tionality to re-create every type of stair you may encounter.
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N O T E Throughout this book, you'll have the opportunity to download custom
% families from the book’s website.

In this section, you’ll focus on creating a staircase by using the traditional
Rise/Run method. Then I'll discuss modifying the boundary of the stairs,
which allows you to create a more unusual shape than that provided out of
the box.

N O T E  Metricusers should not type in mm or other metric abbreviations when
% entering amounts suggested in the exercises. Revit will not accept such abbreviations.
Simply enter the number provided within the parentheses.

To begin, open the file you've been using to follow along. If you didn’t complete
Chapter 9, “Ceilings and Interiors,” go to the book’s web page at www.sybex.com/
go/revit2017ner. From there you can browse to the Chapter 10 folder and find
the file called NER-10.rvt.

The objective of the following procedure is to create a staircase using the Rise/
Run method:

1. In the Project Browser, go to the Level 2 floor plan.

2. Zoom in on the radial entry in the east wing, as shown in Figure 10.1.

Coadaion| 104 ko ot by e cammonre | o
Pres F. for more hetp —
{2)
O S —~ 2
B @)
A 1
y N \
/ , A\
\
=10 —_——— e - __3410
) — £ W L.i,‘{a\
/ Ny “~ |
) L—*—****x—f—f -—————{31)
111 i
| /
1 N/
| .;':. S~
N Z (39
_ N ~
—T-—-—-— — - —-—4
| E P

FIGURE 10.1: Clickthe Stair button on the Circulation panel of the
Architecture tab.
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. On the View Control bar, change Visual Style to Hidden Line.

. On the Circulation panel of the Architecture tab, click the Stair button
(see Figure 10.1).

You're put into Sketch Mode for the stairs you're about to design,
as shown in Figure 10.2.

FIGURE 10.2: TheModify| Create Stair tab, Sketch Mode

On the Components panel of the Modify | Create Stair tab, make sure
the Run button and the Straight button are checked (see Figure 10.2).

In the Properties dialog, change Base Level to Level 1.

. Change Top Level to Level 2.

. Change Multistory Top Level to Level 5 (see Figure 10.3).

Properties x

Assembiled Stair
7" max riser 11" tread

Stair v] {8 Edit Type
2

Constraints
......

Base Level
Base Offset
Topleva T
Top Offset
Desired Stair Het
Multistory Top L
Dimensions
Desired Number of Risers i
Actual Number of Rléers )
et Rser e
Actual Tread Depth |
Tread/Riser Start Number i
lclenmyData e
Comments |

Mark |

Phasing e
Phase Created New Construction
Phase Demalished |None

Properties help Apply

Project Browser - NER-11.rvt l Properties |

FIGURE 10.3: Changing the Element Properties of the stairs
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N O T E  Bysetting the base to Level 1 and the top to Level 2, you give Revit the

% dimensions it needs to calculate the rise of the stairs. When you add the multistory
height, Revit takes the calculation from Levels 1 and 2 and applies that increment up to
the additional floors. Be warned, however, that if the floor-to-floor dimension changes in
one of these levels, you'll have a problem. You’ll then have to create a new staircase start-
ing at the offending level.

9. Pick the intersection of the floor edge and grid 3.1 for the first point
of the stairs. This spot is labeled 1 in Figure 10.4.

IR

FIGURE 10.4: Layingout the stairs

10. Move your cursor to the right. A faint display indicates that you
have a certain number of risers created and a certain number
remaining.

11. When you see that nine risers have been created with nine risers
remaining, pick the spot labeled 2 in Figure 10.4.

12. Move your cursor straight up (north) until you get to the grid inter-
section labeled 3 in Figure 10.4. When you see this, pick the third
point.

13. Move your cursor to the left—all the way past the floor landing.
Revit reports that you have 18 risers created and 0 remaining (see
Figure 10.4).
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14. When the second leg is completed, pick the last point. Revit draws
both legs as well as the landing (see Figure 10.4).

With the basic layout completed, it’s time to examine the perimeter of the
stairs. If you're looking for any architectural design outside of the basic box that
you get when you place a staircase, you'll want to edit the boundary.

Modifying Boundaries

With the main stairs in place and laid out, you can now start modifying the
profile. Given that this is a five-tiered, multilevel staircase, the boundary will be
somewhat limited—Dbut not to the point that you can’t make something pop out
of your design.

To modify the boundary, follow these steps:

1. Select the landing, as shown in Figure 10.5.
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FIGURE 10.5: TheConvertbutton

2. Click the Convert button (see Figure 10.5).

3. When you see the warning that you may be doing irreversible damage,
click Close to dismiss it.

4. With the landing still selected, click the Edit Sketch button, as shown
in Figure 10.6.

467



Chapter 10 « Stairs, Ramps, and Railings
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FIGURE 10.6: ThekEditSketch button

5. On the Draw panel, click the Start-End-Radius Arc button, as shown
in Figure 10.7.
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FIGURE 10.7: Addaradius tothe outside of the landing.
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6. Draw an arc on the outside of the landing at an 8-0” (2400 mm)
radius (see Figure 10.7).

With the radius drawn in, it’s important to pause at this point. What you have
here is an extra line. Similar to when you’re sketching a floor, if you have any
overlapping line segments or gaps, Revit won't let you continue. Also, if you have
any extra lines, Revit won’t let you continue.

Let’s clean up the stairs.

1. Click Modify or press the Esc key twice, and then select the straight
green line at the outside of the landing.

2. Press the Delete key on your keyboard. The line is removed. Your
stairs should look exactly like Figure 10.8.

FIGURE 10.8: Thecompleted boundary

3. Click the Finish Edit Mode button, as shown in Figure 10.9.

Now you can select the railing system to use. Out of the box, Revit provides
only four choices. You'll select one of those choices for this staircase, but you’ll
add to the list later in this chapter.
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FIGURE 10.9: Finishing the sketch

Configuring Railings

Revit provides a small number of railing systems as a default. You can choose
one of these five railings to apply to the staircase during the Sketch Mode of the

stairs.

Follow this procedure to apply a railing to the stairs:

1. On the Modify | Create Stair tab in Sketch Mode, click the Railing
button, as shown in Figure 10.10.
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FIGURE 10.10: Clickthe Railing button.
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. In the Railing dialog box, from the drop-down, select Guardrail — Pipe,
as shown in Figure 10.11.
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FIGURE 10.11: SelectGuardrail - Pipe and the Stringer radio button.

. Under Position, select the Stringer radio button (see Figure 10.11).
Doing so hosts the railing to the stringer.

. Click OK. With the railings in place, you're on your way to completing
this staircase. As a matter of fact, round one is finished.

. To complete the stairs, click Finish Edit Mode on the Modify | Create
Stair tab.

. Close the warning that states that the rail is noncontinuous.

7. Go to Level 1. Your stairs should look like Figure 10.12.
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FIGURE 10.12: Thestairsasdisplayedin the plan
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Normally, when you're dealing with a large, multistory staircase, you should
check it out in 3D to make sure all went as planned. This case is no exception!
Here are the steps:

1. Click the Default 3D View button on the Quick Access toolbar.
2. In the 3D view, zoom in on the radial entry.
3. Select the radial wall. It becomes transparent.

Examine your stairs (see Figure 10.13).

FIGURE 10.13: Thestairsin3D with the radial entry temporarily transparent

Here’s a problem: the railing just stops dead at the bottom of the stringer. This
may have been acceptable practice around the time, say, when the wheel was
still on the drawing board. You need some kind of Americans with Disabilities
Act (ADA) compliance at the bottom of the stairs. To accomplish this, follow
along with the next procedure.

To begin, go to the book’s web page, browse to the Chapter 10 folder, and find
the file called ADA-Pipe.rfa. You can then download it to your computer. Now
perform these steps:

1. On the Insert tab, click the Load Family button.
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Vi N W

10.

11.

Browse to the directory where you stashed the family you just down-
loaded, and load ADA-Pipe.rfa into your model.

Go to the Level 1 floor plan.
Zoom in on the bottom of the stairs.

On the Work Plane panel of the Architecture tab, click the Ref Plane
button.

Offset a reference plane 9 1/2” (237 mm) to the left of the bottom
riser (see Figure 10.14).
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FIGURE 10.14: Addtworeference planes asindicated here.

Type 0" in the offset field and draw another reference plane from the
center line of the bottom railing to the left about 2-0” (600 mm) (see
Figure 10.14).

On the Architecture tab, click the Place A Component button.
In the Properties dialog box, select ADA — Pipe.

Press the spacebar once to rotate the family into place so that it’s ori-
ented as shown in Figure 10.15.

Place the family at the intersection of the two reference planes (see
Figure 10.15), and then press Esc twice or click Modify.
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FIGURE 10.15: Placing the family in the intersection

Extending the Railings

You've added a family to finish the stairs at the bottom. The next step is to
extend the railings on the stairs to meet the new family. There is one obstacle,
though: the railing on the stairs already has an ending post. The trick is to
remove the default ending post and replace it with the custom ADA post you just
loaded into your model.

The objective of the next procedure is to extend the railings on the stairs to
the ADA posts you just added to the model:

1.

In the plan, select the bottom railing, as shown in Figure 10.16. Make
sure you aren’t selecting the stairs.
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FIGURE 10.16: Selecting therailing, not the stairs
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SN TR

In the Properties dialog box, click the Edit Type button.

. Click Duplicate.

Call the new railing Entry Stair Railing.
Click OK.

In the Baluster Placement row, click the Edit button, as shown in
Figure 10.17.
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| Parameter | Value | e
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Rail Structure (Non-Continuou | Edit.. ]

Baluster Placement Edit... ] =
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Landing Height Adjustment  {0" 0"

Angled Joins Add Vertical/Horizontal Segme |
Tangent Joins Extend Rails to Meet i
Rail Connections Trim

136"

T Grewar-112
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Height i3 0"

FIGURE 10.17: ClickEditnextto Baluster Placement.

At the bottom of the Edit Baluster Placement dialog box is a Posts category. In
the Posts category is an option to place a post at the start, end, or corner of the
railing. Follow these steps:

1.

For Start Post (1) and End Post (3), type -6” (-150 mm) for the base
offset, as shown in Figure 10.18.

Click OK twice.

. Select the railing on the inside of the stairs.

Change its type to Entry Stair Railing.

475



Chapter 10 « Stairs, Ramps, and Railings

476
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FIGURE 10.18: Settingthe offset allows the post to extend to the floor

where needed.

It’s time to stretch the railing on the stairs to meet up with the family. This
procedure is best done in a plan view, where you can see exactly how far you

need to stretch the railing.
1. Select the bottom (south) railing.
2. On the Modify | Railings tab, click the Edit Path button.

3. Stretch the magenta line to the point shown in Figure 10.19.
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FIGURE 10.19: Aligning the end of the railing to the new family

4. For the first alignment, pick the back edge of the family you loaded,
as shown in Figure 10.19.
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5. Pick the magenta railing line. (When you hover over the magenta <4 |
line, you'll see an endpoint icon. When you do, click it.) The magenta

Notice that the i
line extends to the family (see Figure 10.19). otice Tt e fne

seems off center. Don’t

6. Click Finish Edit Mode. worty about this—it
will line up when you
7. Go to the default 3D view to make sure the railings align (see finish the sketch.
Figure 10.20).
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FIGURE 10.20: Checkouttherailingin 3D to ensure proper alignment.

8. Select the radial brick wall.

9. On the View Control bar, click the Temporary Hide/Isolate Element
button, as shown in Figure 10.20.

10. Select Hide Element (see Figure 10.20).

11. When you've finished marveling at your fantastic landing, click
the Temporary Hide/Isolate Element button again, and select Reset
Temporary Hide/Isolate.
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It would be nice if this were the only place that this railing extension needed
to go. The rest of the procedure will step you through the process of adding this
extension to the inside railing and then copying it up to the other levels.

1. Return to the Level 1 plan view. Select the ADA — Pipe family you
added to the model.

2. Click the Mirror — Pick Axis button, as shown in Figure 10.21.
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FIGURE 10.21: Mirroring the family

Pick grid 3.1, and your family is mirrored.

Select the inside railing.

On the Modify | Railings tab, click the Edit Path button.
Click the Align button.

N S v W

Align the magenta line with the ADA — Pipe family, as shown in
Figure 10.22.

%

Press Esc twice, and then select both families.

9. On the Modify | Generic Models tab, click the Copy To Clipboard button
on the Clipboard panel (the third panel from the left).
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FIGURE 10.22: Thecopiedfamilies

10. Choose Paste > Aligned To Selected Levels, at the upper left on your
screen.

11. Pick Levels 2, 3, and 4, and then click OK. Does your staircase look
like Figure 10.22?

It’s getting close, but it seems as though there is nothing keeping people from
falling off the second, third, fourth, and fifth levels! I don’t know about you, but
I think this is the perfect place to put a separate railing and tie it into the exist-
ing stair railing.

Landing Railings

Railings, of course, can be drawn independently from a stair. Tying the rail-

ing into the stair, however, requires a little more patience. That being said, it
becomes obvious that Revit reflects the real world when it comes to railings. If
you have a railing that is difficult to build, it will probably be difficult to model.
Also, if you arrive at an intersection that can’t be physically accomplished in the
field, then guess what? You’ll struggle trying to get it into Revit.
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To add some railings at the landings and tie them into the stair railings, follow

these steps:

1. In the Project Browser, go to the Level 2 floor plan.

® N S N A W

Click the Duplicate button.

Propenes beip

On the Architecture tab, click the Railing button.
Make sure Type is set to Handrail — Pipe.
In the Properties dialog box, click the Edit Type button.

Call the new railing Handrail — Pipe — Horizontal Railing.

Click the Edit button next to the Baluster Placement choice.

Select None for the Start and End posts under the Posts category, as
shown in Figure 10.23.
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FIGURE 10.23: Configuring the default settings for the railing type Handrail — Pipe —

Horizontal Railing

9. Click OK twice.

10. Pick a point at the intersection of the reference plane and the south

wall, as shown in Figure 10.24.
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11.
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FIGURE 10.24: Sketchingthe path of the railing

Click the Preview button on the Options bar (see Figure 10.24).

Pick the intersection of the reference plane and the ADA — Handrail
(see Figure 10.24).

Click Finish Sketch.

@ N O T E Youcan have only one continuous railing at a time. If there are gaps in the
; railing, it won't work. For example, the second floor needs three separate railings.

The next step is to add the ADA railing extensions to the north leg of the stairs
and to create a railing between the two stair sections. This process can be a tad
tricky, but once you get the progression, you’ll see why it needs to be done in the
following manner:

1.

Still on the second floor, select the two ADA — Pipe families, and click
the Mirror — Pick Axis button, as shown in Figure 10.25.

Mirror the two families about the building’s center reference plane.
Select the inside railing on the staircase.

Click Edit Path on the Modify | Railings tab.
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5.

6.
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FIGURE 10.25: Mirroring and configuring the two railing extensions

Extend the railing to the front edge of the ADA family, exactly the
same way you did for the south leg of the staircase (see Figure 10.26).
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FIGURE 10.26: Creatingarelationship between the stairs, the landing,
and the handrail

Click Finish Edit Mode.
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7. Repeat the procedure for the outside railing, as shown in

Figure 10.26.

Let’s add a railing to the center and the north side of the landing. This should
be pretty easy.

1.
2.
3.

Start the Railing command.
Make sure Handrail — Pipe — Horizontal Railing is the current railing.

Draw a line down 1'-0” (300 mm) from the intersection of the upper-
south ADA railing extension and the reference planes, as shown in
Figure 10.27.
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FIGURE 10.27: C(reating the middle railing

Draw a line up 1'-0” (300 mm) from the top ADA railing extension on
the south leg of the stairs (see Figure 10.27).

On the Draw panel, click the Start-End-Radius Arc button (see
Figure 10.27).

Draw a 4—0” (1200 mm) arc from the endpoints of the top and bottom
lines (see Figure 10.27).

Click Finish Sketch.

Draw another railing, as shown in Figure 10.28.
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FIGURE 10.28: C(reatingthe northern railing

What you need to do now is add this configuration to the third, fourth, and
fifth floors. The fifth floor, however, will need to have a configuration change

1. Select the middle railing, the two ADA railing extensions, and the
northern railing, as shown in Figure 10.29.
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FIGURE 10.29: Copytheselecteditems to the clipboard.

. On the Modify | Multi Select tab, click the Copy To Clipboard button
(see Figure 10.29).
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4.
5.
6.

Click Paste > Aligned To Selected Levels, as shown in Figure 10.30.

5
=)

Select | Properties

E ¥ KEcope -0
e O Gan s =8
% Poin - R
‘ E Paste from Clipboard ‘

Ba BBl == O

+ O =
PO OTTyax=

Modify

Madify | Multi-Selec,
Properties | Align&d to Selected Levels
‘ |" Aligned to Selected Views
Aligned to Current View
Common (4)
Identity Data Aligned to Same Place
Comments ]|
Mark | IZ Aligned to Picked Level
Phasing i
Phase Created | New Constructi..
Phase Demolish... | None
|Properties help Apply |
ER-11.rv - Project Browser =
=-, Views (Discipline) -
& Architectural
& Floor Plans

Corridor Parapet z
Level 1
Level 2

Farapet
Roof

T.0. Footing
West Parapet
west Roof

FIGURE 10.30: Paste> Aligned To Selected Levels

Paste the items to Level 3 through Level 5.
Go to Level 5.
Change Detail Level to Fine.

Delete the middle railing, and make the south railing extend to the
ADA post, as shown in Figure 10.31.
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FIGURE 10.31: Reconfiguring the fifth floor
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8. Go to a 3D view, and select the radial brick wall to make it transparent.
Check out your stairs, as shown in Figure 10.32.
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FIGURE 10.32: Checkoutyourawesome stairs!

Phew! You've built a set of stairs. The good thing is that it’s one sweet staircase.
The bad thing is that you used all the default layouts and materials. Next, we’ll
get into some more complicated shapes and styles.

Creating a Winding Staircase

Before you get started, you should know that you'll create this staircase by using
the separate stair components. You can try to make a winding staircase by using
the Run function, similar to the one you used earlier. But in many cases (espe-
cially when you run into an existing staircase in either a renovation project or
an addition), you may need to draft the stairs and then model over the top of the
drafting lines. What? Drafting in Revit? Of course. How else can you expect to
get anything done?

The first thing you’ll need to do is make modifications to the floor in a specific
area to create a landing. Follow these steps:

1. In the Project Browser, go to the Level 2 floor plan.



Creating a Winding Staircase

2. Zoom in on the area between the corridor and the east wing, as
shown in Figure 10.33.
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FIGURE 10.33: C(reatingalanding.You'll add a door in a moment.

3. Select the Level 2 floor in the east wing.

4. Click the Edit Boundary button on the Mode panel of the Modify |
Floors tab.

5. Sketch a landing that is 807 (2400 mm) long x 7'-10” (2350 mm)
wide. Center it on the reference plane, as shown in Figure 10.34.

[imsert| annotete [7Analyze  Massing &site . Collaborate  View . Manage 1
B Spot Elevation Detail E'ne €3 Revision Cloud A Text
AP Spot Coordinate Region

ABC
Detail Line (DL) v Check Spelling
h 1 Spot Slope g Compo| Creates view-specific lines. ";I Find/ Replace

Text

Press F1 for more help

FIGURE 10.34: ClicktheDetail Line button on the Annotate tab.

6. Click Finish Edit Mode on the Mode panel. If you're asked if you want
to attach the walls to the bottom of the floor, click Yes.

With the landing in place, you can now copy a door up to this level. To do this,
you’ll go to the first floor and copy the door that resides there. You can do this
on your own, or you can follow along with these steps:

1. In the Project Browser, go to the Level 1 floor plan.
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2. Select door 100B.

3. Copy the door to the clipboard (click Copy To Clipboard on the
Clipboard panel).

4. Choose Paste > Aligned To Selected Levels.
5. Select Level 2, and click OK.

6. In the Project Browser, go back to Level 2. The door and the landing
are in place.

Next you’ll create a winding set of stairs. The first task is to lay out the shape
in the plan using simple drafting lines. The second task is to model over the
lines you added, by using various stair tools as follows:

1. Select the Annotate tab.
2. Click the Detail Line button.

3. On the Draw panel, click the Start-End-Radius Arc button, as shown
in Figure 10.35.

lace Detail Lines

R /s0c0.

® -
e e 1% Line Style:
D O=—ﬂ: g8 6] += - f‘ " E.‘frjé &, Thin Lines
@ it = @ DX -
Modify View | Measure Create Draw Line Style|
Radius: | 1' 0

FIGURE 10.35: WiththeStart-End-Radius Arc button selected, start at the
midpoint of the landing and then go southwest at an angle of 135° and a distance of
11°-0” (3300 mm).
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10.

11.

12.
13.

For the first point of the arc, pick the midpoint of the landing (see
Figure 10.35).

Move your cursor down, at 135° from the first point you just picked.

Extend your cursor 11'-0” (3300 mm), as shown in Figure 10.36, and
then click to set the second point.

”
-9
37/353.. /

/ !

FIGURE 10.36: Picking the third point to form the arc. It will be tangent
upon the first two points you picked.

To form the arc, move your cursor to the right until the radius snaps
into place. When it does, pick the point as shown in Figure 10.36.

Press Esc.
On the Draw panel, click the Pick Lines icon.

On the Options bar, add an increment of 2'—0” (600 mm) to the Offset
field (see Figure 10.37).

Offset the center arc to the right and then to the left, forming a 4'—0”
(1200 mm) overall winder, as shown in Figure 10.37.

Press Esc.

Click the Line tool, make sure Offset is set to 0, and then draw a
straight line at each end of the arcs, as shown in Figure 10.38.
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FIGURE 10.37: Addingtwo more arcs based on the centerline of the first

1

FIGURE 10.38: Addingastraightline at each end of the arcs

OK, take a breather. Compare the examples in the book to what you have. Are
you close? If not, go back and investigate.

% N O T E  Getused to this drafting thing; it’s still very much a part of BIM, regard-
; less of whether people say you can’t draft in Revit!
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The next step is to make an array of the straight lines you just added. These
lines will wind up being the guidelines for your risers.

1. Press Esc, and then select the smaller arc, as shown in Figure 10.39.

-
b )4 T T _l

— 1

Lines : Detail Lines

FIGURE 10.39: Selectingthesmallerarc

2. In the Properties dialog box, select Center Mark Visible.
3. Select the line at the left end of the arcs, as shown in Figure 10.40.

a Madify | Lines -A

¥ Ecowe- W & I' & e = (g
H Eﬁé—lcut-'?p?a'%oﬂ%g%nu;v(‘. g:g

B/ Pioin + 2 & v Q EER.j oo
es | Clipboard Geometry Modify View | Measure Create Line Style
[ﬂ@ ¥ Group and Associate Number: 18 Move To:( ) 2nd @) Last = | Activate Dimensions|  Center of rotation: | Place| Defaul
® Define a ne:

FIGURE 10.40: Arraying the line to create your own treads

4. Click the Array button on the Modify | Lines tab.
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On the Options bar, be sure Radial is selected.
Make sure Group And Associate is selected.

Type 18 for the number.

® N S W

Click Move To: Last on the Options bar. (Remember that you aren’t
actually moving this line; you're simply copying it to the last place in
the array.)

9. Click the Place button next to the Center of Rotation category on the
Options bar, and pick the center of the arc.

10. Pick a point along the first line (the one at the lower left).
11. Pick the second point along the upper-right line.

Your array is complete. Check out Figure 10.41 to see how the finished stairs
will look.

FIGURE 10.41: Thestairs whencomplete
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Now you can begin modeling the stairs. This procedure is nothing more than
tracing the lines you’ve already added to the model. To do this, you’ll use the
available tools that you haven’t touched in the previous staircase. Follow these

steps:

-

10.
11.

12.
13.

14.

15.
16.
17.
18.

19.

® N S 0 A~ W N

On the Architecture tab, click the Stairs button.

In the Properties dialog box, change Base Level to Level 1.
Change Top Level to Level 2.

Click Edit Type.

Click Duplicate.

Call the stairs Corridor Entry Stairs.

Click OK.

In the Construction category, click the cell to the right of Run Type.
It contains the text 2” (50 mm) Tread 1” (25 mm) Nosing 1/4” (6 mm)
Riser. When you click in the cell, you see a [...] button. Click it.

Choose Cherry for Tread Material.
For Riser Material, do the same.

Under the Treads category, select Front, Left and Right for the Apply
Nosing Profile row.

Click OK.

Scroll down to the Supports category, and change Right Support
from Stringer (Closed) to Carriage (Open).

Click into Carriage — 2” Width (50 mm) to the right of Right Support
Type.

Click the small [...] button to the right of the cell.
Change Material to Mahogany. Click OK.
Change Left Support to Carriage (Open).

Add Mahogany as the material to the Carriage — 2” Width. Your
Properties dialog box should look like the one shown in Figure 10.42.

Click OK to get back to the model.
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Minimum Run Width
Calculation Rules

Run Type
Landing Type
Function

Right Support
Right Support Type
Right Lateral Offset
Left Support

Left Support Type
Left Lateral Offset
Middle Support
Middle Support Type
Middle Support Number

2 Tresd 1" Nosing 1/4” Riser ] Tread |
| Non-Monalithic Landing Tread Thickness S
Interior Nosing Length o
Nosing Profile " Stair Nosing - Pan : Stair Nosin
Carriage (Open) |} [Tread Profile o
|Cariage - 2" Width Apply Nosing Profile
oo *
| Carriage (Open) Riser ]
Carriage - 2° Width Slanted ]
o0 Riser Thickness ooy
[4] Riser Profile | Default
| Carriage - 2" Width Riser To Tread Connection | Extend Riser Behind Tread

0

<o ||

o [ cmm J[ see

Apply

FIGURE 10.42: Customizing the stairs

It’s time to add the stairs to the model. To do this, you'll first sketch the

boundary.

1. On the Modify | Create Stairs tab in Sketch Mode, click the Create
Sketch button, as shown in Figure 10.43.

Modify | Create Stair

ow wodrR. i@ B L L.
' & Lending “l| Set Show Ref Viewer o Railing
é Support Create Sketch
e s ‘ : Creates a custom run by sketching the shape. el
FIGURE 10.43: Clickthe Create Sketch button.

On the Draw panel, click the Pick Lines icon.

Pick the two arcs defining the outside of the stairs. Green arcs are
copied directly on top of them.

On the Draw panel, click the Riser button.

On the Draw panel, click the Pick Lines icon.

Pick all of the lines you arrayed. This includes the bottom and the top
lines (see Figure 10.44).
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I 0

I,g__ﬁ_i 0D

FIGURE 10.44: Picking the detail lines to lay over the stair components

7. Click the Stair Path button.

8. Click the Pick Lines button.

9. Pick the centerline of the staircase.
10. Click Finish Edit Mode on the Mode panel.
11. Click the Railing button.

12. Change the railing to Handrail — Pipe, make sure the position is set
to Treads, and click OK.

13. Click the Finish Sketch button (the green check mark).

With the stairs roughed in, you need to get a better look at them. If you use
the default 3D view, you need to turn off way too many items to see your stairs.
Let’s add a perspective view, just to see what’s going on here!

If you're confident about adding your own perspective view, go ahead and put
one in and name it East Entry from Corridor. If not, follow along with these
steps:

1. In the Project Browser, go to the Level 1 floor plan.
2. On the View tab, click the 3D View > Camera button.
3. Pick the first point shown in Figure 10.45.
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" | Crestes s 30 view trom the perspective of  camera placediinthe |
view

Press FL for mors help | [f Video b loading...

FIGURE 10.45: Addingthe perspective view

4. Pick the second point shown in Figure 10.45.

5. In the Project Browser, find the new perspective view, and rename it
East Entry from Corridor.

6. In the perspective view, turn on Realistic. (It’s located on the View
Control bar at the bottom of the view.)

7. Check out the view (see Figure 10.46)!

FIGURE 10.46: Lookingnice




Creating a Winding Staircase 497

The next series of steps involves mirroring the stairs to the other side of the
landing. Then, of course, you need to add a landing railing so people don’t just
walk out the door and off the ledge.

1. Go to the Level 2 floor plan in the Project Browser.

2. Select the stairs and the railings, as shown in Figure 10.47.

Category: Count:
[ Array 1. Check All
|Detail Groups 18
| Lines (Thin Lines) 4 Check None
[|Railings 2
] Stair Paths 1
[] Stairs 1
[] Stairs: Runs [ B |
[] Stairs: Supports 2
Goprats 2|
Total Selected Items: ]

FIGURE 10.47: Selecting the items to be mirrored

% N O T E Toselect only the stairs and the railings, you can pick a window around
= the entire set of lines, groups, railings, and stairs. From there, you can click the Filter
button on the Ribbon, and select only Stairs And Railings.

3. On the Modify | Multi-Select tab, click the Mirror > Pick Mirror Axis
button, as shown in Figure 10.48.

4. Pick the center reference plane. (I told you this thing would come in
handy.)

Your stairs are now mirrored to the other side of the landing (see
Figure 10.48).
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FIGURE 10.48: Themirroredstairs

Let’s tie in the railings. If you’re feeling up to the challenge, try it on your own
by using the railing Handrail — Pipe. If not, just follow along with these steps:

1. On the Architecture tab, click the Railing button.

2. In the Type Selector, change the type to Handrail — Pipe, as shown in
Figure 10.49.

Properties @

Railing -
Handrail - Pipe

Railings vJ
= Railing : Handrail - Pipe
Constraints

Base Level Level 2 Press F1 for more help

Base Offset 00"
T e T
S

Length 22 57
Iderltrly G

Comments i
o )

|Properties help Apply

FIGURE 10.49: Settingthelanding handrail type
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10.

11.

On the Draw panel, click the Pick Lines icon.
Set Offset to 4” (100 mm).
Pick the landing lines to offset in the railing (see Figure 10.50).

PHG -Q-2-8-LC0CA G-

Maodify | Railings > Sket
| l? s ol T} R s
N ST BNt X/
Modify ll (o)) O =, - */)« . N !
S - e M= x Lo | o
Select | Properties | Clipboard Geometry Modify View |Measwe  Create | Mode
Offset 0 47 Lock
[propenes——— x | ) ‘ |
i i | D
Railing i
Handrail - Pipe |
Railings | 68 Edit Type I
Constraints &
Base Level Leveli j
Base Offset oo [
Tread/Stringer Offset oo
Dimensions & F‘
Length 2 412
Identity Data %
Comments. | I *
Mark T T T ety e—
‘ . k ] == - =
Phasing ." | ] Z1H |

FIGURE 10.50: Therailingon the landing

. After the offsets are complete, click the Line icon on the Draw panel.

Set Offset to 0.

. Draw the lines extending from the midpoint snap of the stair railing

to the landing railing (see Figure 10.51).

. Trim the corners so your railings look like Figure 10.51.

. On the Mode panel, click Finish Edit Mode.

You may have to flip the railing by selecting it and then clicking the
Flip arrow.

Add two more railings between the stairs and the brick wall. Your
stairs should look like Figure 10.52.
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Remember, you must
create only one railing
atatime. If you try

to do more than one
continuous line, Revit
won't let you proceed.
Try creating one short
railing and mirroring it.
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Modity | Railings ~ Sketeh Path
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FIGURE 10.51: Connecting the landing railing to the stair railing

FIGURE 10.52: Thecompletedlanding
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Great! You're getting there. Now you'll see how a staircase and the accom-
panying railings come together. For example, it sure would be nice to have a
railing with spindles or, better yet, panels added to it. Also, a nice half-round
bullnose would improve your staircase. The next section will focus on this
concept.

Stair and Railing Families

Similar to the model as a whole, stairs and railings comprise separate families
that come together to form the overall unit. Although stairs and railings are
considered a system family (a family that resides only in the model), they still
rely heavily on hosted families to create the entire element.

The next procedure will involve loading separate families into the model and
then using them in a new set of stairs and railings that you’ll create in the west
wing.

1. In the Project Browser, go to the Level 3 floor plan, and change Detail
Level to Fine.

Zoom in on the west wing.
On the Architecture tab, click the Floor button.
In the Properties dialog box, click the Edit Type button.

Select the 6” (152 mm) Concrete With 1”7 (25 mm) Terrazzo floor
system from the Type drop-down list, as shown in Figure 10.53.

LA

X

[~ Famiy: System Family: Floor Z|
Type: 6" concrete with 1” Terrazzo zl

Duplicate...

Type Parameters

FIGURE 10.53: Youmustadda floorat the Level 3 floor plan for the stairs to
have a landing.

6. Click OK.
7. On the Draw panel, click the Pick Walls button.

8. Pick the walls, and make sure the lines are set to the core centerline,
as shown in Figure 10.54.
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Modify | Floors > Edit Boundary
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FIGURE 10.54: Addingthe floor outline to the walls. Be sure to offset the
line 50" (1500 mm) from the south wall. This will be the stair landing.

9. When picking the south wall, set Offset to 5'~0” (1500 mm) in the
Options bar.

/ T 1 P Again, make sure you have no gaps or overlapping lines. Use the Trim/Extend
’9 Single Element command to clean up the lines to look like the figure.

10. Once the sketch lines are in place, trim the corners, and click Finish
Edit Mode on the Mode panel.

11. Revit asks if you want to attach the walls that go up to this floor’s
bottom. Click No.

12. Revit asks if you want to cut the overlapping volume out of the walls.
Click Yes.

Your floor is now in place. The next item you’ll tackle is creating a completely
custom railing system.

Creating a Custom Railing System

Next, you’ll load the components that make up your stairs. Although Revit
makes an attempt to supply you with some families, in this case you’ll down-
load the families included with this book by going to the book’s web page at
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www. sybex.com/go/revit2017ner. From there, browse to the Chapter 10 folder
and find the following files:

» 6210 (2-5_8).rfa
landing.rfa
post.rfa

raised panels.rfa

vV v.VvyYy

spindle.rfa
» stair nosing.rfa

To get started, you need to load the families into your model so they’re avail-
able when it comes time to assemble your new railing. If you remember how to
do this, go ahead and load all the families that you just downloaded from the
web page. If you need some assistance, follow these steps:

1. On the Insert tab, click Load Family.
2. Find the files that you downloaded from the web page.
3. Select all of them, and click Open to load them.
4. Save the model.
The next step is to create a new railing and add some of these items to it.

1. In the Project Browser, find the Families category, and expand it, as
shown in Figure 10.55.

L
ER-11.rvt - Project Browser
Circular-11/2" -
Pipe - Wall Mount
Rectangular - Wall Mount
= Panel - Glass
2'g"
& Railing
Entry Stair Railing
Glass Panel - Bottom Fill
Guardrail - Pipe
Guardrail - Rectangular
Handrail - Pipe
Handrail - Pipe - Horizontal Railin

Handrail - Rectangular
& spindle L3

& Support - Metal - Circular
Support - Metal - Circular -
« ] »

|

FIGURE 10.55: Therailing family called Handrail - Rectangular
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10.
11.
12.
13.

Find the Railing category and expand it.

Find Handrail — Rectangular, and double-click it (see Figure 10.54).

Click Duplicate.

Call the new railing Wood Railing with Spindles.

Click OK.
Click OK again.

In the Project Browser, under the Families category, scroll down until
you see Top Rail Type, as shown in Figure 10.56.

78 -
Railing
Entry Stair Railing
Glass Panel - Bottom Fill
Guardrail - Pipe
Guardrail - Rectangular
Handrail - Pipe
Handrail - Pipe - Horizontal Railing
Handrail - Rectangular
Wood Railing with Spindles
& spindle
1
Support - Metal - Circular
Support - Metal - Circular
Termination - Wood - Rectangular
Termination - Wood - Rectangular
& Top Rail Type
6210
Circular - 11/2°
Elliptical - 11/2" x11/8"
Rectangular- 2" x 2°
Ramps
Roofs
Specialty Equipment
Stairs
& Assembled Stair
7" max riser 11" tread
Coridor Entry Stairs
= Camiage
Carriage - 2* Width
& Cast-In-Place Stair
Bullnose Stairs
Monolithic Stair
& Monolithic Landing -

Project Browser - NER-11.rvt I Properties

o

L}

o

0 &8 88

e

Famiy: Lood
Type: (6210 v [ Duplicate... ]
Type Porameters

Parameter Value o
Oetautoin [
Fillet Radius 0o
Hand Clearance -0 15/16° L
Profile 16210 (2-5_8) : 2-5/8" P
Projection (071506
Transitions | Gooseneck
Material | Cherry
Extension Style | None
Length ()
Plus Tread Depth a

=
=10 B % GHmEHEP ¢ G A«

FIGURE 10.56: Changing the rail. Note that you can add as many rails as you

want. Here, you’re adding only one.

Double-click the Circular — 1 1/2” (38 mm) Top Rail Type.

Click Duplicate.

Change the name to 6210, and click OK.
Change Profile to 6210 (2-5_8) : 2 5/8” (67 mm).

Change Transitions to Gooseneck.
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14.
15.
16.

17.
18.
19.
20.

Change Material to Cherry.
Click OK.

Under the Families category in the Project Browser, double-click
Wood Railing With Spindles, located in the Railing category.

Scroll down, and change Top Rail Type to 6210.
Click OK.

Click the Edit button in the Baluster Placement row.

In the Main Pattern area, change Baluster Family to Spindle: 1”7 (25 mm)
(see Figure 10.57).

Family: Railing Type: 'Wood Railing with Spindles
Main pattern
ase Top | Dist. from Delete
Name Baluster Famil Base offset Top offset| | previous Offset
1 | Pattern start N/A N/A N/A  IN/A NfA NJA N/A
2 | Regular baluster | spindie: 17 jHost 0 0" TopRail |0°0" 0O 4" 00 Up
3 [Pattern ena NA R |[N/A N/A | N/A N/A 0O N/A —
Break Fattern at: Angle: | 0.000° Fattern Length: 0' 4°
sty Y — S—
[ ] use Baluster Per Tread On Stairs Balusters Per Tread: | 2 Baluster Family: | Baluster - Square : 3/4 =
Posts
Name Baluster Family Base pace Top o8 Space Offset :
offset offset
1 |Start Post |Baluster - Square : Host 00" TopRai 00" 0038 00 P
2 |Corner Po | Baluster - Square : Host 00" TopRai 00" 00" oo
3 |End Post |Baluster - Square : Host 00" TopRai 00" -0°03/8" 0 0 |15
C—— soge: 0000
i ][ o [

FIGURE 10.57: Addingthespindle to the Main Pattern area

21. Just below the Main Pattern area is the Use Baluster Per Tread On

Stairs option. Select it, as shown in Figure 10.58.

22. To the right is the Balusters Per Tread field. Specify two balusters per

tread (see Figure 10.58).

23. Change Baluster Family to Spindle: 1”7 (25 mm), as shown in

Figure 10.58.
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Justify: Beginning v| ExcesstengthFil: [None - Spadng: 0 0
g; Use Bakuster Per Tread On Stairs Balusters Per Tread: 2 Baluster Family:
Posts
N Baluster Famil B =) g Top | of 5
lame aluster Family ase | eroet °P | offset| SP2ce £
Hest 0'0" Handra 0'0" 0' 038" |0
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FIGURE 10.58: Specifying two balusters per tread and no actual posts

24. In the bottommost field is the Posts category. Change each of the
three posts to None in the Baluster Family column. Your spindles are
all you need (see Figure 10.58).

25. Click OK twice.

You may or may not have noticed that you didn’t get the opportunity to
change the baluster’s material as you did with the railing. This action must be
done in the family itself, as follows:

1. In the Project Browser, the Spindle category is just below Railing, as
shown in Figure 10.59. Expand Spindle to expose the 1”7 (25 mm) family.

@ Baluster - Square
=~ Railing

Entry Stair Railing

Guardrail - Pipe

Guardrail - Rectangular

Handrail - Pipe

Handrail - Rectangular

Landing Handrail

Wood railing with Spindles E
- spindle 1

[#- Ramps

@~ Roofs lk

(6] Specialty Equipment
@

E
£
[
[

< | mn »

FIGURE 10.59: Finding the Spindle : 1” family to access the material

2. Double-click the 1”7 (25 mm) family to open its Type Properties
dialog box.

3. Find the Material row, click into the <By Category> field, and click
the [...] button.
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4. Change Material to Cherry.
5. Click OK twice.

This completes the railing setup. Once you add it to the stairs, however, some tweak-
ing will certainly be required. The next step is to customize the stairs themselves.

Creating Custom Stairs

This is the third staircase you've created in the same chapter, so you've certainly
gained some experience regarding the placement of stairs and railings into the
Revit model. You're also becoming familiar with the stair and railings dialog
boxes. This last procedure will tie all of that together.

Let’s create that staircase.

1. On the Architecture tab, click the Stairs button.

2. In the Properties dialog box, make sure you choose Cast-In-Place
Stair Monolithic Stair, as shown in Figure 10.60, and click the Edit

Type button.
Location Line: Run: Center ~ Offset: 000"
Properties x
Cast-In-Place Stair o
Monolithic Stair
Ly
Stair : ___x BB EditType
Constraints. - 0
Bas evel
Base Offset 00
Top Level Level 3
Top Offset [
Desired Stair Height 00
M‘L]Itlstory Top Level None
Dimensions [
Desired Number of Risers 18
Actual Number of Risers no T
Actual Riser Height 0" 61717256
Actual Tread Depth 1o
TS
T — - ik SRR i
Comments
Mark
= - L e
Phase Created New Construction
Phase Demolished None
Properties help Apply
Project Browser - NER-11.rvt { Dnopenie;l

FIGURE 10.60: Configuring the stairs. As you can see, you have quite a few options.
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N VN N W

N

9.
10.
11.
12.
13.
14.
15.
16.
17.

18.
19.
20.
21.
22.
23.

. Click Duplicate.

. Call the new staircase Custom Bullnose Stairs.

. Click OK.

. Under Construction, next to Run Type, click into the 3/4” Nosing cell,

and then click the [...] button.

. Change the nosing profile to stair nosing : stair nosing.

. Apply the nosing profile to Front, Left and Right.

Select the Riser check box.

Change the riser thickness to 3/4” (19 mm).

For Riser To Tread Connection, choose Extend Tread Under Riser.
Change Monolithic Material to Mahogany.

Under Treads, make sure Treads is turned on.

Change Tread Material to Mahogany.

Change Riser Material to Mahogany.

Click OK.

Click the 7” (178 mm) Thickness cell next to Landing Type, and click
the [...] button to the right.

Click Duplicate.

Call the new landing 1’-0” (300 mm) Mahogany Landing.
Change Monolithic Thickness to 1'-0” (300 mm).

Change Monolithic Material to Mahogany.

Click OK.

Click OK again.

It’s time to configure some of the layout properties. These will allow you to
calculate the rise/run count as well as some basic offsets you'll need.

1.
2.

3.

In the Properties dialog box, set Base Level to Level 1.
Set Base Offset to 6 5/8” (152 mm), as shown in Figure 10.61.

Set Top Level to Level 3. (Yes, this is going to be one long
staircase!)
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Properties @

Cast-In-Place Stair
Bullnose Stairs

-

Stair -| 8 Edit Type

Constraints 2 a
Base Level Level 1

Becofet i e 14
Top Level "Level 3{}
Top Offset oo

"Desired Stair Height |19 53/8°

Dimensions 2
Desired Number of .. 34 i
Properties help Apply

FIGURE 10.61: TheBaseOffsetvalueissetto 65/8” (152 mm).

The next step is to place this monster into the model. Although you didn’t
specify a multistory staircase, you'll need multiple landings to give your visitors
a breather as they travel up the stairs. This layout will require a little more care
in the initial planning stage.

1. On the Work Plane panel, click the Ref Plane button.

2. Click the Pick Lines button, and then offset a grid, as shown in <4 |
Figure 10.62.

The nice thing about
using reference planes
while in Sketch Mode

! is that they will disap-
o pear once you finish
. — ~ the sketch. If you need
I : J to go back and edit the
stairs, the reference
planes will appear
again!

I plg = = %
[EafMbg
e L
s s
Lok

FIGURE 10.62: Usingdimensions to lay out the centerlines of the stairs
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3. Click the Railing button.

4. Change the railing type to Wood Railing With Spindles, and make
sure Position is set to Treads. Click OK.

5. On the Modify | Create Stairs tab in Sketch Mode, click the Run button.

6. Draw your stairs as shown in Figure 10.63. (Pick the points as the
figure is sequenced.)

A

| N,

FIGURE 10.63: Pickingtheintersections of the reference planes to
determine where the stairs will go

7. Verify that your plan looks like Figure 10.64.

FIGURE 10.64: Thestairsinplace
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8. Click Finish Sketch. Your stairs should look like Figure 10.65.

UPE : :

FIGURE 10.65: Thestairsasshowninplan

9. Go to a 3D view to check out the stairs. They should resemble
Figure 10.66.

FIGURE 10.66: Thestairsasshownin 3D. Notice the nice bullnose
and the railings.
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The next step (pun intended) is to add a landing to the bottom of the stairs.
This requires creating a family. Although we will cover creating families in
Bonus Chapter 2, “Creating Families,” this one has been created, and you've
downloaded the families needed to create this step in the stairs.

Adding a Custom Landing

You left the 6 5/8” (152 mm) offset for the bottom tread because you need to
introduce your own version of how that bottom tread should look. If you haven’t
already loaded the family, go to www.sybex.com/go/revit2017ner. From there,
browse to the Chapter 10 folder and find the Landing.rfa and Post.rfa files.
After you've loaded the families, proceed with these steps:

1. In the Project Browser, go to the Level 1 floor plan.

2. On the Architecture tab, click the Place A Component button.
3. In the Type Selector, find and select the Landing family.
4

. As you'’re inserting the family, press the spacebar to rotate the landing
into the correct position.

5. Place the landing under the last tread at the point shown in
Figure 10.67.

=Tt T -T—F=-
T M I A
L A P Y
T [y S S e

FIGURE 10.67: Placingthelanding

Press Esc twice.
Select the landing.
In the Properties dialog box, change Tread Material to Cherry.

® ® N O

Change Base Material to Mahogany, and click OK (see Figure 10.68).
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Properties (s]
\ landing -l
Generic Models (1) v| H8 Edit Type
radius location 0 10" -
base height 0558
Materials and Finishes &
tread material Cherry
base material g
Dimensions b &
tread thickness 01"
tread depth 10
tread bearing 0 8" L
Properties help Apply

FIGURE 10.68: Changingthelanding material to match the theme
of the staircase

The next task is to add a post.

Adding a Gooseneck

In this style of railing system, it would be nice to have a gooseneck to catch the
railing as it slopes downward and spiral it into the post. Of course, Revit doesn’t
have families for this built in, but this book does! If you didn’t download the post
family earlier in this chapter, go to the book’s web page, browse to the Chapter 10
folder, and find the Post_up. rfa file. After you download it and load it into the
model, follow these steps:

1. In the Project Browser, go to the Level 1 floor plan, and zoom in on
the landing area, as shown in Figure 10.69.

2. On the Architecture tab, click the Place A Component button.
3. In the Properties dialog box, select Post_up With Gooseneck.

4. As you're placing the post, press the spacebar twice to flip it into the
correct orientation.

5. Place it on the landing slightly away from the stair railing.

6. Select the post, and change Offset to 6 5/8” (152 mm) in the
Properties dialog box.

% N O T E Ifthe end of the post seems to be clipped in the plan, you need to adjust
= the view range in the Properties dialog box. Right now, the 4'-0” (1200 mm) clip plane may
be a tad too low. To fix this, find the View Range row in the Properties dialog box and click
the Edit button. In the View Range dialog box, adjust Cut Plane Offset to 4'-6” (1250 mm).



Chapter 10 « Stairs, Ramps, and Railings

g 0¥ &8 By g = =- (/]
& N & Bl Bz = ? & [ | B
y = b G- =l 5 o B b E 079 | g
O P 2A Q}O L= ‘f' &' | ramiy |
| Select ~ | Properties | Clipboard | Geometry Modify | View |Measure | Create | Mode |
Modify | Generic Models | || Moves With Nearby Elements
Properties x[ ’ ,
’
/ - - 7
post.up - N v,
with gooseneck Al P \
- Y
| Generic Models (1) ~| B8 Edit Type
Constraints - A § \
Level al
Host .lP¥E| Level 1 -
Offset 065/ [ = | |
Moves With Nearby Eleme... L &
Construction ' * 4
Post embedment 10
Graphics o \
gooseneck down .Z
Imbed post 0
Materials and Finishes LE ’
rail material | Cherry | I |
post material Cherry \
Nimencinne . b —1
Properties help Apply
Project Browser - NER-1Lrvt | Properties | Yr=10 MO % GMED I BE <
Cligk-1g select, TAB for altemates, CTRL adds, SHIFT unselects. &b

FIGURE 10.69: Placing the post with the gooseneck

7. Select the post again (if it’s not still selected).

8. Click the Move button.

9. Move the post from the midpoint of the post’s end to the midpoint of

the stair railing’s end, as shown in Figure 10.70.

FIGURE 10.70: Moving the post to align with the stair railing
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10. Select the post again (if it’s not selected already).

11. In the Properties dialog box, go to the Materials And Finishes cat-
egory, and change materials for both the rail and the post to Cherry.

12. Mirror the post to the other railing.
In 3D, your landing should now look like Figure 10.71.

FIGURE 10.71: Thecompletedlanding

Adding a Railing to the Landing

Let’s add the railing to the Level 3 balcony. Compared to that landing you just
did, this is going to be a snap! If you feel as though you have the experience
required to add your own landing railing, take a shot at it. If not, follow these
steps:

1. In the Project Browser, go to Level 3.
Zoom in on the stairs.

Right-click one of the railings on the stairs, and click Create Similar.

» W N

Sketch a railing that is 4” (100 mm) in from the face of the landing,
as shown in Figure 10.72.
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$

FIGURE 10.72: Addingtherailing. This process is becoming old hat!

5. Make sure you have a “leg” tied into the stair railing.
6. On the Railing panel, click Finish Edit Mode.
7. Repeat the procedure on the other end (see Figure 10.73).

FIGURE 10.73: Bothrailingsarein place.

N O T E Torepeat the procedure on the other end, either you can mirror the rail-

% ing you just put in and then edit it to reach the far end of the landing or you can start the
Railing command and do it again. | recommend mirroring the railing, selecting the new
railing, and then selecting Edit Path from the Modify | Railings tab. You can then grip-edit
the right end to meet the wall. This assures you that the railing will be aligned with the
railing on the stair.
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The last step is to add a raised-panel stile and rail system along the third-floor

wall.

Adding a Raised-Panel Stile and Rail System

The first thing you'll need to do is to add an entrance to the large Level 3 train-
ing room. The corridor will then receive a custom line-based, raised-panel

family.

10.
11.
12.
13.

. In the Project Browser, go to the Level 3 floor plan.

On the Architecture tab, click the Door button.

In the Properties dialog box, select Single-Raised Panel With
Sidelights : 36” x 84” (86 mm x 2134 mm).

Place it in the corridor wall aligned with the stairs, as shown in
Figure 10.74.

AN

{p)

AN | == I
FIGURE 10.74: Pickthe pointasshown for the elevation.

/1

Copy the door 10'—0” (3000 mm) to the right (see Figure 10.73).
On the View tab, click the Elevation button.

In the Change Element Type menu in the Properties dialog box,
select Interior Elevation.

Pick a point, as shown in Figure 10.75; then press Esc.

In the Project Browser, right-click the new elevation, and rename it
West Wing Balcony Elevation.

Open the West Wing Balcony elevation.
Stretch the crop region so that you can see the entire west wing.
On the Architecture tab, click the Place A Component button.

Scroll down the Type Selector list until you find Raised Panels (see
Figure 10.75).
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FIGURE 10.75: Picking the far wall to establish a work plane

14. In the Work Plane dialog box, make sure Pick A Plane is selected, and
then click OK.

15. Pick the far wall (see Figure 10.75). If you don’t have the raised panel
family, you can download it at the book’s web page; it’s called Raised
Panel.rfa. Once it’s downloaded and loaded into the model, proceed
with the next step.

16. On the Modify-Place Component tab, click the Place On Work Plane
button, and pick the base point shown in Figure 10.76.

©

[Comipor Paapet am|

T

FIGURE 10.76: Addingtheline-based, raised-panel family
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17. Pick the second point.

N O T E Ifyoucan’t seem to pick the points specified in Figure 10.75, go ahead and
pick two points close to the area indicated in the figure. After you place the line-based
family, you can select it and grip-edit the ends to extend to the wall’s edges as shown in
the figure. Also, if the panels are too high, simply move them down to the floor or align
them after the panels are in place.

18. Start the Place A Component command again, if it’s not already run-
ning, and add the raised-panel family between the two doors and to
the right. This completes the raised panels for this level.

19. Select all the raised panel families on this floor (remember to hold
the Ctrl key to add to the selection).

20. In the Materials And Finishes category of the Properties dialog box,
change Frame Material to Cherry.

21. Change Panel Material to Mahogany. See Figure 10.77.

CENTY Oy WoR i
.

FIGURE 10.77: Changingthe material

22. Change Visual Style to Realistic. Your elevation should look like
Figure 10.78.
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FIGURE 10.78: Thefinished raised-panel, line-based family

Wow! That was quite a bit about stairs. If you take anything away from this
chapter, it should be the knowledge that stairs don’t come easy, but you can cre-
ate any staircase if you know you’ll need to create families.

The last section of this chapter focuses on adding ramps to the model. As far
as Revit procedures go, ramps are the kid sister to stairs.

Adding Ramps

When you think of a ramp in Revit, think of a one-tread, one-rise staircase at a
1/12 pitch. A ramp is placed in the model exactly the same way as a set of stairs.
You still have the run method, and you can still sketch the ramp by using a

boundary.

That being said, let’s start placing a ramp in your model.

1.
2.

N S A

In the Project Browser, go to the Level 1 floor plan.

Zoom in on the radial entry of the east wing at grid intersection F-5
(see Figure 10.79).

You need to create a flat landing, so, on the Architecture tab, click the
Floor button.

Click Edit Type in the Properties dialog box.
Select Generic — 12”7 (305 mm) Filled.
Click Duplicate.

Call the new floor Exterior Concrete Slab.
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/_/1| - 0"

1"- 0"

FIGURE 10.79: Sketching theslab perimeter

8. Click OK.

9. Click the Edit button in the Structure row.
10. Change Structure [1] Material to Concrete — Cast-In-Place Concrete.
11. Change Thickness to 6” (150 mm).
12. Click OK twice to get back to the model.

13. Place the concrete at the points shown in Figure 10.78.

‘"’ W A RN I NG Makesureyou're using Pick Lines Mode and are picking the out-
\ / side face of brick. That extra line represents the water table above this floor’s level.

14. When the slab is in place, click the Finish Edit Mode button.

15. Click No in the next dialog box.

Now you can add the ramp. You'll set the ramp’s properties for the top to
Level 1, and the bottom will also be at Level 1 but with an offset.

1. On the Architecture tab, click the Ramp button.
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. In the Properties dialog box, click Edit Type.
. Click Duplicate.

. Call the new ramp Exterior Concrete Ramp.
. Click OK.

. Give it a 6” (150 mm) thickness.

. Change Function to Exterior.

W NN AW N

. For the ramp material, click the [...] button, and specify Concrete —
Cast-In-Place Concrete, as shown in Figure 10.80.

Family:  [System Family: Ramp

Type: [Exterior Concrete Ramp

Type Parameters

| Parameter

Thickness
Function

Text Size
Text Font

Ramp Material Concrete - Cast-in-Place Concre

Maximum Incline Length 30' 0

Keynote

Model
Manufacturer
Type Comments
URL

Description

<< Preview oK Cancel {

FIGURE 10.80: Modifyingthe Type Properties

9. Notice that Maximum Incline Length is set to the ADA standard of
30°-0” (10000 mm).

10. In the Other category, notice that Ramp Max Slope is set to 1/12.
11. Click OK.
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12. In the Properties dialog box, set Base Level to Level 1.

13. Set Base Offset to -2—6” (-750 mm), as shown in Figure 10.81.

14.
15.
16.
17.

18.

19.

Properties & E
Ramp n
Exterior Concrete Ramp
Ramps v] Edit Type
Constraints 3
Base Level Level 1
Base Offset -2 8"
Top Level Level 1
Top Offset [
Multistory Top Level ‘None
Graphics e
Up text up
Down text DN
Up label (2]
Down label =

Show Up arrow in all views []
Dimensions

Width 50"

Identity Data 2
Mark

Phasing : o
Phase Created New Construction
Phase Demolished None

Properties help Apply

FIGURE 10.81: Settingthe properties

Set Top Level to Level 1.
Set Width to 5'-0” (1500 mm) (see Figure 10.81).
On the Draw panel, click the Run button.

In the model, click the first point for the ramp, similar to the point

shown in Figure 10.82. (You have to place the point near the midpoint.

Revit doesn’t allow you to snap while in Sketch Mode.)

Move your cursor down the view (south) 15—0” (4500 mm), as shown
in Figure 10.82. (You'll see the temporary dimension.)

Pick a point about 6’-0” (1800 mm) below the end of the ramp, in
alignment with the right boundary, as shown in Figure 10.83. After
you pick the second point, the view should read “30” (10000 mm) of
inclined ramp created, 0 remaining.”

523
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FIGURE 10.82: Pickthefirstpointon the landing, and then move your
cursor down 15’-0” (4500 mm).

20. Move your cursor to the right until the ramp stops (see Figure 10.83).

M

FIGURE 10.83: Thesecondleg of the ramp

21. On the Modify | Create Ramp tab in Sketch Mode, click the Railing
Type button.

22. Select Handrail — Pipe in the Railing Type dialog box that opens.
23. Click OK.
24. Click Finish Edit Mode.
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25. Select the entire ramp (including the railing).

26. Move the ramp so that the midpoint of the top of the ramp meets the
midpoint of the landing slab.

You may notice immediately that the ramp is sloping in the wrong direction. 4 00 |
Also, you need to tie the railings into the slab. If you would like to pick around

and see how to do these things on your own, go right ahead. Otherwise, follow It bestif you keep

moving your cursor
these steps: past the end of the
ramp. This ensures that
the entire ramp has

2. Pick the small blue arrow—this flips the direction of the ramp. been putin place.

1. Select the ramp.

3. On the Architecture tab, click the Railing button.

4. In the Properties dialog box, click Edit Type, change the type to
Handrail — Pipe, and click OK.

5. Draw a railing 8” (200 mm) in from the slab edge, as shown in
Figure 10.84.

FIGURE 10.84: Addingtherailingjustasyou've been doing
this entire chapter
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6. Mirror the slab, the ramp, and the railing to the other side of the
building, as shown in Figure 10.85.

FIGURE 10.85: Thetworamps

7. Save the model.

Creating ramps is necessary in almost every project. Some will be easier than
others, and, at times, they may try your patience. Keep at it, and before long
you'll have the experience you need to feel confident in creating ramps.

Are You Experienced?
Now you can...

v/ create stairs with the conventional method by using the Run com-
mand to generate the height and length you need

v/ create stairs by first laying out the geometry by placing line work in
the model and then tracing over the lines with the stair components

v/ determine the difference between the boundary and the riser when
you need to sketch the stair profile
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v/ load necessary components used to customize stairs and railings
such as railing types, spindles, posts, and landings

v/ use separate components and access them in the Project Browser to
place materials

v/ configure railings based on the baluster placement and the railing
placement as used in the Element Properties of the railing

v/ determine how to tie a railing into a stair railing by using offsets and
by aligning the railing sketch with the stairs

v/ add aline-based, raised-panel family to complete millwork items
v/ create ramp landings and create the actual ramp

v/ determine the length of the ramp based on the rise and run of
the slope



